
RELEASE NOTES 

 

N4917BACA 100G Optical Receiver 

Test Application 
This document contains latest information on the Keysight N4917BACA 100G Optical Receiver 

Test Application. 

 

Related Document 

For detailed information, refer to the following document for this application:  

- “Keysight_N4917BACA_UserGuide.pdf” 

This document can be found at the following location after you install the application: 

C:\Program Files\ Keysight\M8070B\Apps\N4917BACA\help  

The M8070B documents can be located by clicking Start > All Programs > Keysight M8070B > 

Keysight M8070B Documentation. Alternatively, you can also visit 

www.keysight.com/find/m8070b to find the latest versions of M8070B documents. 

http://www.keysight.com/find/m8070b
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Installation Steps 

To install the N4917BACA 100G Optical Receiver Test Application, perform the following steps: 

1. Review the System Requirements for this application. 

2. Download the installer file:  

a. Go to the link: http://www.keysight.com/find/N4917BACA 

b. Click the Technical Support link on the right side of this page. 

c. Select the Drivers, Firmware & Software tab. 

d. Click the N4917BACA 100G Optical Receiver Test link and download the installer 

file. 

3. In case IO Libraries Suite is not installed on your machine, download it from 

http://www.keysight.com before you proceed to installation of the N4917BACA software. 

4. Double-click the downloaded installer file on your PC. 

5. Please note that both Keysight License Manager 6 and Keysight License Manager 5 are 

installed on your system when you install N4917BACA software.  

When prompted, install Keysight License Manager, if the same is not already available on 

your computer.  

6. Follow and respond to the installer prompts. 

7. Accept the terms of the Keysight Software End-User License Agreement and click Next. 

8. Click Install. 

9. Click Finish to finish the installation and exit the installation wizard. 

10. Install the required licenses via the Keysight License Manager (if not done before). To know 

about the required licenses, refer to the User Guide. 

https://www.keysight.com/en/pd-2901129-pn-N4917BACA/optical-receiver-stress-test?nid=-31929.1237978.00
http://www.keysight.com/
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Getting Started 

To access the installed N4917BACA application, perform the following steps: 

1. From the Start menu of the Windows Operating System, select All Programs > Keysight 

M8070B Applications > Launch Keysight N4917BACA. 

2. If you are launching the Keysight N4917BACA application for the first time, the End-User 

License Agreement window appears. Select Agree to continue. 

The N4917BACA application banner is displayed. 

3. If there is a single instance of the M8070B software running locally, the N4917BACA 

application launches after automatically getting connected to the M8070B software.  

4. If the N4917BACA application does not detect any instance of the M8070B software 

running locally, the Connect to M8070 window appears. 

5. When the application starts successfully, it will start with the default layout and will show 

the Set Up tab. 

For more information on how to use the various features in the N4917BACA application, 

refer to the Keysight N4917BACA 100G Optical Receiver Test Application Online Help. 
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Keysight N4917BACA Software Version 2.5.3 

Release Date: September 18, 2023 

File Name: SetupM80RxIEEE100G02050003.exe 

Operating System Microsoft Windows 7, Windows 8, Windows 10, (64 bit) 

Requirements Category  

(e.g., instrument software version): 

Please see the product data sheet on keysight.com 

License: Please see the product data sheet on keysight.com 

New Features 

- Added support for the following new transmission standards:

o 10GBASE-LR/-ER/-SR IEEE 802.3ae

o 40GBASE-LR4/-ER4/-SR4 IEEE 802.3ba

- Support for N7779C tunable lasers

Bug Fixes 

- Fixed a defect that caused the software to stop with an exception when capturing the DCA

stressed eye screenshot from a high-resolution monitor.

- Fixed a defect that inhibited the software from using the second internal laser source

(1550nm) in the reference transmitter modules 8194xA.

- Fixed a defect in the calibration result PDF export.

- Fixed a defect in the calibration result CSV export.

Known Issues 

- When opening the application’s user guide in the Acrobat Reader PDF Viewer from within 
the N4917BACA application (Help → View Test Procedure), error pop-up messages have 
been observed in some cases. To view the PDF document in this case the, please follow 
one of the following workarounds:

o Open the PDF document directly from with the Acrobat Reader application either 
by browsing to the installation location “c:\Program

Files\Keysight\M8070B\Apps\N4917BACA\help\” or downloading the file from 
Keysight.com

o Change the default file viewer program for PDF files in Windows to a different 
software, as e.g., Microsoft Edge.
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- Unexpected behavior might be observed when running the software and the software 

prerequisites on Windows 10 operating system. As a workaround, ensure that you install 

and run the N4917BACA application and the other software prerequisites as an 

administrator. 

In scenarios where the user does not have administrator rights, the suggested workaround 

is to install the software and prerequisites as an administrator and enable full control 

(read, write access) mandatorily to the following folders: 

o C:\Program Files\Keysight\M8070B\Apps\N4917BACA 

o C:\ProgramData\Keysight\M8070B\Apps\N4917BACA 

o C:\ProgramData\Microsoft\Windows\Start Menu\Programs\Keysight M8070B 

Applications 

o C:\Users\Public\Documents\Keysight\M8070B\Apps\N4917BACA  

 

and preferably to the following additional folder: 

o C:\Users\<user_name>\Documents\Keysight\M8070B\Apps\N4917BACA 

- Saved projects files from previous versions (< 2.0.0) cannot be opened anymore due to the 

change of the application title. To re-enable opening these projects files, the tags 

“Application name” in the main project file (*.proj) and compliance file (compliance.lim) in 

the project directory must be modified manually and should read the actual application 

name (see application window or name in project file saved with latest version). 

- When an appended series of calibrations fail during the first trial, the results of successive 

trials will not be displayed in the Results tab even if these calibrations were successful. 

Restart the series in this case or use “Replace results” to overwrite the results of the 

previous runs. 

- Depending on the targeted standard and particular HW configuration, a 6dB or 10dB 

attenuator might be required in the sinusoidal interference signal path. Use this approach 

when the calibration fails, and an error related to clipping of AWG amplitude is reported 

(Error message: Set range clipped).  

- The TDEC verified by the software and the one displayed in eye-mode measurement of the 

FlexDCA software using default parameters are based on different OMA definitions, 

resulting in different TDEC values in presence of strong ISI. The value reported by the 

N4917BACA software is measured compliant to the method defined in the standards.   

- In some of the scenarios that involve the use of an external CDR for transmission standards 

where its usage is optional, calibrations might lead to failing results. 

- Laser safety errors are sometimes returned when the reference transmitter is calibrated, 

and an external TLS source is used. As a workaround restart the test task or reduce the 

maximum output power of the tunable laser (“Maximum TLS output Power” parameter in 

the Configure tab). Alternatively, toggle the “Switch off PG during REFTX recal” parameter 

in the Configure tab. 
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- When the Keysight N77xx Viewer software is connected via USB to a N77xx type 

attenuator which is also used by the N4917BACA application, time-out errors might occur. 

To prevent these errors during ORST testing, disconnect the N77xx Viewer software from 

the attenuator.  

- In some non-EN-US locales, commas might be the preferred decimal mark instead of the 

decimal point. Similarly, use of digit group separators might be preferred in some locales. 

This might lead to misinterpretation of locale-specific formats when working with numeric 

values.  While the N4917BACA application has some validation mechanisms to check for 

any confusion arising out of the non EN-US formats, it is best to avoid the use of locale-

specific formats. Thus, use "point" as the decimal mark and avoid use of digit group 

separators. 

Please contact Keysight Technical Support (www.keysight.com/find/supportrequest) if you 

encounter any other issue.  

  

http://www.keysight.com/find/supportrequest
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Keysight N4917BACA Software Version 02.00.0050 

Release Date:  April 05, 2023 

File Name: SetupM80RxIEEE100G02000050.exe 

License: Please see the product data sheet on keysight.com 

 

The system requirements for the N4917BACA application remain the same as for the previous 

release. See system requirements.  

Modification 

- Update with Keysight License Manager 5 

Known Issues 

- See Known Issues. 

 

 

Keysight N4917BACA Software Version 02.00.0020 

Release Date:  August 01, 2022 

File Name: SetupM80RxIEEE100G02000020.exe 

License: Please see the product data sheet on keysight.com 

 

The system requirements for the N4917BACA application remain the same as for the previous 

release. See system requirements.  

Fixed Issues 

- Fixed a defect that caused TDEC measurements to abort due to an incompatibility with the 

modified TDEC measurement algorithm introduced in FlexDCA version A.06.90 or newer. 

Known Issues 

- See Known Issues. 
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Keysight N4917BACA Software Version 02.00.0011 

Release Date:  January 14, 2022 

File Name: SetupM80RxIEEE100G02000011.exe 

License: Please see the product data sheet on keysight.com 

 

The system requirements for the N4917BACA application remain the same as for the previous 

release. See system requirements.  

Fixed Issues 

- Fixed a critical defect that caused the software to abort the receiver tests when using an 

external clock recovery (CDR), due to a SCPI error. 

- Adjusted the notation of measurement units in the results tables (added spaces between 

the result value and unit in some cases).  

- Fixed a defect that caused the software to not update some standard settings when 

loading a saved project file or restoring the project settings after an unexpected software 

crash. 

Enhancements 

- Support for the internal clock recovery available in newer M8046A error detector modules 

(requires corresponding license option). 

Known Issues 

- See Known Issues. 

 

Keysight N4917BACA Software Version 02.00.0005 

Release Date:  January 19, 2021 

File Name: SetupM80RxIEEE100G02000005.exe 

License: Please see the product data sheet on keysight.com 

 

The system requirements for the N4917BACA application remain the same as for the previous 

release. See system requirements.  
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Fixed Issues 

- class tunable laser as optical source. 

- Fixed a defect that would cause the stress signal calibration to abort while generating the 

noise interference pattern for PSM4 transmission standard in certain instrument 

configurations. 

Known Issues 

- See Known Issues. 

 

Keysight N4917BACA Software Version 02.00.0001 

Release Date November 9, 2020 

Operating System Microsoft Windows 7 (64 bit)  

Microsoft Windows 8 (64 bit) 

Microsoft Windows 10 (64 bit) 

Memory 8 GB RAM [minimum] 

Display resolution WXGA+ (1440 x 900) [minimum] 

PC Interfaces USB 

LAN 

GPIB (optional) 

Instrument Firmware M8040A BERT - M8070A/B System Software. For 

the supported versions see the Software Pre-

requisites row. 

DCA-M/DCA-X - FlexDCA version A.06.60.378 or 

later 

8164B LMS - Ver.V5.25 or later 

BERT M8040A-BU2 mainframe with USB option 

M8070A-0TP/ONP/1TP/1NP System Software. For 

the complete list of licenses, see Chapter 2 of the 

User Guide. 

M8045A-G32/0G3/0G4/801 High Performance 

BERT module 

M8057A/B Remote head for M8045A pattern 

generator, 1 channel 

M8046A-A32/801 Analyzer module 

Signal Generator for Sinusoidal and Gaussian Noise 

Interference 

M8195A-002/16G Arbitrary Waveform Generator or 

M8196A-002 Arbitrary Waveform Generator or 
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81150A-001 Pulse Function Arbitrary Noise 

Generator or 

81160A-001 Pulse Function Arbitrary Generator 

N5171B-503 EXG X-series RF Analog Signal 

Generator 

N5172B EXG X-Series RF Vector Signal Generator 

M8054A Interference Source, 32 GHz 

Lightwave Measurement System 8164B LMS Mainframe 

Tunable lasers 

N7776C Tunable Laser 1240-1380 nm or 

N7778C Tunable Laser 1240-1380 nm or 

81602A-013 Tunable Laser 1250-1370 nm or 

81606A-113 Tunable Laser 1240-1380 nm or 

81608A-113 Tunable Laser 1240-1380 nm or 

81609A-113 Tunable Laser 1240-1380 nm 

 

Reference Transmitters 

81490A-E05 Reference Transmitter or  

81490A-E09 Reference Transmitter or 

81490A-E10 Reference Transmitter (multimode – 

for SR only) 

81491A-085 Reference Transmitter (multimode - 

for SR only) 

81491A-135 Reference Transmitter 

81492A-E01 Reference Transmitter (56GBaud) 

81492A-135 Reference Transmitter (56GBaud) 

 

81000FI Optical Connector Interface 

81000NI Optical Connector Interface 

 

Optical attenuators:  

81576A Attenuator module (straight SMF) or 

81577A Attenuator module (angled SMF) or 

N7761A external Attenuator (1 ch straight SMF) or 

N7762A external Attenuator (2 ch straight SMF) or 

N7764A external Attenuator (4 ch straight SMF) 

N7751A external Attenuator (1 ch with 2 optical 

power meter channels, SMF) 



 

 
11 / 29 Keysight N4917BACA 100G Optical Receiver Test Application Release Notes 

N7752A external Attenuator (2 ch with 2 optical 

power meter channels, SMF) 

N7766A Optical Attenuator for Multimode Fiber 

(2ch) 

N7768A Optical Attenuator for Multimode Fiber 

(4ch) 

DCA-X Oscilloscope N1000A DCA-X Wide-Bandwidth mainframe 

86100D-ETR/PTB/200/201/300/401 DCA-X 

mainframe 

 

N1030A/B Optical plug-in module for the N1000A 

DCA-X mainframe 

86105D-281/IRC Electrical/Optical SMF module or 

86115D-282 /IRC Dual Optical SMF module 

 

86107A-020 Precision Time Base (not required, if 

DCA-X has the option –PTB) 

86115D-282/IRC 

Because of their low noise and superior speed, it is 

recommended to use DCA-M series oscilloscopes 

instead of DCA-X series oscilloscopes. 

DCA-M Oscilloscope N1092A one optical channel or 

N1092B two optical channels or 

N1092C one optical, two electrical channels or 

N1092D four optical channels or 

N1092E two optical, two electrical channels 

options LOJ/PLK/IRC/200/201/300/401/500 

Clock Recovery N1077A-232/SMS/JSA Optical/Electrical Clock 

Recovery 

Software Pre-requisites Keysight IO Library rev. 18.1 or above 

M8070B system software for M8000 series ver. 

7.2.40.2 or later and 

M8070ADVB Advanced Measurement Package for 

M8000 series ver. 1.3.200.4 

N1010A FlexDCA Remote Access System 

A.06.60.378 or later 

In the newer releases of FlexDCA, analysis 

packages that combine many separate items that 

were available previously under individual licenses 

are now available. Refer to the Data Sheet to see 
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how features of previous FlexDCA releases map 

into the more recent FlexDCA packages. For the 

N4917BSCB 400G Optical Receiver Test 

Application, you require the following analysis 

package: 

N1010100A R&D Package 

 

Alternatively, use the older licenses: 

N1010A-9FP (PAM-N Analysis Software) 

N1010A-TFP (TDECQ Transmitter and Dispersion 

Eye Closure for PAM4) 

Application Requirements Keysight M8070B System Software. For the 

required licenses, see User Guide. 

Keysight M8045A with options G32 or G64; 0G3 or 

UG3; 0G4 or UG4; 801 

Keysight M8046A with options A32 or A64; 801 

Keysight N4917BACA 100G Optical Receiver Test 

Application. For the required licenses, see User 

Guide. 

File Name SetupM80RxIEEE100G02000001.exe 

License: Please see the product data sheet on keysight.com 

 

Fixed Issues 

- Fixed a defect because of which the M8054A interference source output amplifier was not 

being turned on, when recalling the instrument settings from a previously stored stressed 

eye calibration. The output amplifier is now turned on, as expected (observable in M8070 

GUI), resulting in a correctly impaired stress signal. 

 

Known Issues 

- Unexpected behavior might be observed when running the software and the software 

prerequisites on Windows 10 operating system. As a workaround, ensure that you install 

and run the N4917BACA application and the other software prerequisites as an 

administrator. 

In scenarios where the user does not have administrator rights, the suggested workaround 

is to install the software and prerequisites as an administrator and enable full control 

(read, write access) mandatorily to the following folders: 

o C:\Program Files\Keysight\M8070A\Apps\N4917BACA 

o C:\ProgramData\Keysight\M8070A\Apps\N4917BACA 
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o C:\ProgramData\Microsoft\Windows\Start Menu\Programs\Keysight M8070A 

Applications 

o C:\Users\Public\Documents\Keysight\M8070A\Apps\N4917BACA  

 

and preferably to the following additional folders: 

o C:\Users\<user_name>\Documents\Keysight\M8070A\Apps\N4917BACA 

o C:\Users\<user_name>\Documents\Keysight\M8070A\Apps\N4917BACA 

- Saved projects files from previous versions (< 2.0.0) cannot be opened anymore due to the 

change of the application title. To re-enable opening these projects files, the tags 

“Application name” in the main project file (*.proj) and compliance file (compliance.lim) in 

the project directory must be modified manually and should read the actual application 

name (see application window or name in project file saved with latest version). 

- When an appended series of calibrations fail during the first trial, the results of successive 

trials will not be displayed in the Results tab even if these calibrations were successful. 

Restart the series in this case or use “Replace results” to overwrite the results of the 

previous runs. 

- Depending on the targeted standard and particular HW configuration, a 6dB or 10dB 

attenuator might be required in the sinusoidal interference signal path. Use this approach 

when the calibration fails, and an error related to clipping of AWG amplitude is reported 

(Error message: Set range clipped).  

- The TDEC verified by the software and the one displayed in eye-mode measurement of the 

FlexDCA software using default parameters are based on different OMA definitions, 

resulting in different TDEC values in presence of strong ISI. The value reported by the 

N4917BACA software is measured compliant to the method defined in the standards.   

- In some of the scenarios that involve the use of an external CDR for transmission standards 

where its usage is optional, calibrations might lead to failing results. 

- Laser safety errors are sometimes returned when the reference transmitter is calibrated, 

and an external TLS source is used. As a workaround restart the test task or reduce the 

maximum output power of the tunable laser (“Maximum TLS output Power” parameter in 

the Configure tab). Alternatively, toggle the “Switch off PG during REFTX recal” parameter 

in the Configure tab. 

- When the Keysight N77xx Viewer software is connected via USB to a N77xx type 

attenuator which is also used by the N4917BACA application, time-out errors might occur. 

To prevent these errors during ORST testing, disconnect the N77xx Viewer software from 

the attenuator.  

- In some non-EN-US locales, commas might be the preferred decimal mark instead of the 

decimal point. Similarly, use of digit group separators might be preferred in some locales. 

This might lead to misinterpretation of locale-specific formats when working with numeric 

values.  While the N4917BACA application has some validation mechanisms to check for 

any confusion arising out of the non EN-US formats, it is best to avoid the use of locale-
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specific formats. Thus, use "point" as the decimal mark and avoid use of digit group 

separators. 

 

Please contact Keysight Technical Support (www.keysight.com/find/supportrequest) if you 

encounter any other issue. 

 

Keysight N4917BACA Software Version 02.00.0000 

Release Date October 9, 2020 

Operating System Microsoft Windows 7 (64 bit)  

Microsoft Windows 8 (64 bit) 

Microsoft Windows 10 (64 bit) 

Memory 8 GB RAM [minimum] 

Display resolution WXGA+ (1440 x 900) [minimum] 

PC Interfaces USB 

LAN 

GPIB (optional) 

Instrument Firmware M8040A BERT - M8070A/B System Software. For 

the supported versions see the Software Pre-

requisites row. 

DCA-M/DCA-X - FlexDCA version A.06.60.378 or 

later 

8164B LMS - Ver.V5.25 or later 

BERT M8040A-BU2 mainframe with USB option 

M8070A-0TP/ONP/1TP/1NP System Software. For 

the complete list of licenses, see Chapter 2 of the 

User Guide. 

M8045A-G32/0G3/0G4/801 High Performance 

BERT module 

M8057A/B Remote head for M8045A pattern 

generator, 1 channel 

M8046A-A32/801 Analyzer module 

Signal Generator for Sinusoidal and Gaussian Noise 

Interference 

M8195A-002/16G Arbitrary Waveform Generator or 

M8196A-002 Arbitrary Waveform Generator or 

81150A-001 Pulse Function Arbitrary Noise 

Generator or 

81160A-001 Pulse Function Arbitrary Generator 

http://www.keysight.com/find/supportrequest
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N5171B-503 EXG X-series RF Analog Signal 

Generator 

N5172B EXG X-Series RF Vector Signal Generator 

M8054A Interference Source, 32 GHz 

Lightwave Measurement System 8164B LMS Mainframe 

Tunable lasers 

N7776C Tunable Laser 1240-1380 nm or 

N7778C Tunable Laser 1240-1380 nm or 

81602A-013 Tunable Laser 1250-1370 nm or 

81606A-113 Tunable Laser 1240-1380 nm or 

81608A-113 Tunable Laser 1240-1380 nm or 

81609A-113 Tunable Laser 1240-1380 nm 

 

Reference Transmitters 

81490A-E05 Reference Transmitter or  

81490A-E09 Reference Transmitter or 

81490A-E10 Reference Transmitter (multimode – 

for SR only) 

81491A-085 Reference Transmitter (multimode - 

for SR only) 

81491A-135 Reference Transmitter 

81492A-E01 Reference Transmitter (56GBaud) 

81492A-135 Reference Transmitter (56GBaud) 

 

81000FI Optical Connector Interface 

81000NI Optical Connector Interface 

 

Optical attenuators:  

81576A Attenuator module (straight SMF) or 

81577A Attenuator module (angled SMF) or 

N7761A external Attenuator (1 ch straight SMF) or 

N7762A external Attenuator (2 ch straight SMF) or 

N7764A external Attenuator (4 ch straight SMF) 

N7751A external Attenuator (1 ch with 2 optical 

power meter channels, SMF) 

N7752A external Attenuator (2 ch with 2 optical 

power meter channels, SMF) 

N7766A Optical Attenuator for Multimode Fiber 

(2ch) 
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N7768A Optical Attenuator for Multimode Fiber 

(4ch) 

DCA-X Oscilloscope N1000A DCA-X Wide-Bandwidth mainframe 

86100D-ETR/PTB/200/201/300/401 DCA-X 

mainframe 

 

N1030A/B Optical plug-in module for the N1000A 

DCA-X mainframe 

86105D-281/IRC Electrical/Optical SMF module or 

86115D-282 /IRC Dual Optical SMF module 

 

86107A-020 Precision Time Base (not required, if 

DCA-X has the option –PTB) 

86115D-282/IRC 

Because of their low noise and superior speed, it is 

recommended to use DCA-M series oscilloscopes 

instead of DCA-X series oscilloscopes. 

DCA-M Oscilloscope N1092A one optical channel or 

N1092B two optical channels or 

N1092C one optical, two electrical channels or 

N1092D four optical channels or 

N1092E two optical, two electrical channels 

options LOJ/PLK/IRC/200/201/300/401/500 

Clock Recovery N1077A-232/SMS/JSA Optical/Electrical Clock 

Recovery 

Software Pre-requisites Keysight IO Library rev. 18.1 or above 

M8070B system software for M8000 series ver. 

7.2.40.2 or later and 

M8070ADVB Advanced Measurement Package for 

M8000 series ver. 1.3.200.4 

N1010A FlexDCA Remote Access System 

A.06.60.378 or later 

In the newer releases of FlexDCA, analysis 

packages that combine many separate items that 

were available previously under individual licenses 

are now available. Refer to the Data Sheet to see 

how features of previous FlexDCA releases map 

into the more recent FlexDCA packages. For the 

N4917BSCB 400G Optical Receiver Test 

Application, you require the following analysis 

package: 
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N1010100A R&D Package 

 

Alternatively, use the older licenses: 

N1010A-9FP (PAM-N Analysis Software) 

N1010A-TFP (TDECQ Transmitter and Dispersion 

Eye Closure for PAM4) 

Application Requirements Keysight M8070B System Software. For the 

required licenses, see User Guide. 

Keysight M8045A with options G32 or G64; 0G3 or 

UG3; 0G4 or UG4; 801 

Keysight M8046A with options A32 or A64; 801 

Keysight N4917BACA 100G Optical Receiver Test 

Application. For the required licenses, see User 

Guide. 

File Name SetupM80RxIEEE100G02000000.exe 

License: Please see the product data sheet on keysight.com 

 

Enhancements 

- Support for automated optical stressed receiver sensitivity test for optical transceivers 

compliance with the following IEEE 802.3 2015 MSA standard: 

o 100GBASE-PSM4 

- Support for the more recent Keysight tunable laser sources:  

o N7776C Tunable Laser 1240-1380 nm 

o N7778C Tunable Laser 1240-1380 nm 

- Support for the N1030A/B Optical plug-in modules for the N1000A DCA-X mainframe. 

- Support for the following new Interference source for sinusoidal interference and random 

interference in all the supported measurement flavors: 

o M8054A Interference Source, 32 GHz 

- Support for new firmware versions 

o M8070B - 7.2.40.2 

▪ M8070ADVB Advanced Measurement Package for M8000 Series - 1.3.200.4 

o FlexDCA - A.06.60.378 

o M8195A SFP – 4.0.0.0  

- Added the following new configuration variables: 

o Force Multichannel Attenuator Reset – By default, this configuration variable is set to 

“false”, which means that if you reset or turn off one channel of the connected 

multichannel attenuator, it does not cause a reset or turning off of the remaining 
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channels.  

If set to “true”, a reset or turning off of one channel will reset/turn off all the channels 

in the multichannel attenuator. 

o Noise Interferer Amplitude – Amplitude of the noise interferer component (rms value) 

o Noise Interferer Lower Frequency - Specifies the lowest frequency of the noise 

interferer component. 

o Noise Interferer Higher Frequency - Specifies the highest frequency of the noise 

interferer component. 

o Noise Interferer Crest Factor – Specifies the crest factor of the noise interferer 

component, i.e., the ratio of the peak value to the standard deviation. 

o REFTX Recalibration Threshold – Specifies the threshold level that triggers an REFTX 

recalibration when measured TCH value is below the specified value. 

o PSM4 jitter type - Selects the jitter type (BUJ or PJ2) used for stress signal calibration. 

 

Fixed Issues 

- Fixed the earlier behavior of the application causing all the channel of a connected 

multichannel attenuator to get reset or turned off when one channel was reset or turned 

off. A new configuration variable has been added for this. 

- Enabled the application to run without a connected error detector module and without 

M8070ADVB license when these are not required, e.g., when running a stressed eye 

calibration. 

- The software now performs a check for the availability of the M8070ADVB package for 

M8070B and a valid license for using it, at the time of startup. This package is required for 

External CDR control, Jitter tolerance testing, and DUT control interface (DCI). 

- The Error Detector Compare Mode configuration variable now supports the following three 

values for the correct handling of M8046A error detector module: 

o Differential 

o Single Ended Normal 

o Single Ended Complement 

 

Known Issues 

- Unexpected behavior might be observed when running the software and the software 

prerequisites on Windows 10 operating system. As a workaround, ensure that you install 

and run the N4917BACA application and the other software prerequisites as an 

administrator. 

In scenarios where the user does not have administrator rights, the suggested workaround 

is to install the software and prerequisites as an administrator and enable full control 

(read, write access) mandatorily to the following folders: 
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o C:\Program Files\Keysight\M8070A\Apps\N4917BACA 

o C:\ProgramData\Keysight\M8070A\Apps\N4917BACA 

o C:\ProgramData\Microsoft\Windows\Start Menu\Programs\Keysight M8070A 

Applications 

o C:\Users\Public\Documents\Keysight\M8070A\Apps\N4917BACA 

 

and preferably to the following additional folders: 

o C:\Users\<user_name>\Documents\Keysight\M8070A\Apps\N4917BACA 

o C:\Users\<user_name>\Documents\Keysight\M8070A\Apps\N4917BACA 

- Saved projects files from previous versions (< 2.0.0) cannot be opened anymore due to the 

change of the application name. To re-enable opening these projects files, the tags 

“Application name” in the main project file (*.proj) and compliance file (compliance.lim) in 

the project directory must be modified manually and should read the actual application 

name (see application window or name in project file saved with latest version). 

- When an appended series of calibrations fail during the first trial, the results of successive 

trials will not be displayed in the Results tab even if these calibrations were successful. 

Restart the series in this case or use “Replace results” to overwrite the results of the 

previous runs. 

- Depending on the targeted standard and particular HW configuration, a 6dB or 10dB 

attenuator might be required in the sinusoidal interference signal path. Use this approach 

when the calibration fails, and an error related to clipping of AWG amplitude is reported 

(Error message: Set range clipped).  

- The TDEC verified by the software and the one displayed in eye-mode measurement of the 

FlexDCA software using default parameters are based on different OMA definitions, 

resulting in different TDEC values in presence of strong ISI. The value reported by the 

N4917BACA software is measured compliant to the method defined in the standards.   

- In some of the scenarios that involve the use of an external CDR for transmission standards 

where its usage is optional, calibrations might lead to failing results. 

- Laser safety errors are sometimes returned when the reference transmitter is calibrated, 

and an external TLS source is used. As a workaround restart the test task or reduce the 

maximum output power of the tunable laser (“Maximum TLS output Power” parameter in 

the Configure tab). Alternatively, toggle the “Switch off PG during REFTX recal” parameter 

in the Configure tab. 

- When the Keysight N77xx Viewer software is connected via USB to a N77xx type 

attenuator which is also used by the N4917BACA application, time-out errors might occur. 

To prevent these errors during ORST testing, disconnect the N77xx Viewer software from 

the attenuator.  

- In some non-EN-US locales, commas might be the preferred decimal mark instead of the 

decimal point. Similarly, use of digit group separators might be preferred in some locales. 

This might lead to misinterpretation of locale-specific formats when working with numeric 
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values.  While the N4917BACA application has some validation mechanisms to check for 

any confusion arising out of the non EN-US formats, it is best to avoid the use of locale-

specific formats. Thus, use "point" as the decimal mark and avoid use of digit group 

separators. 

 

Please contact Keysight Technical Support (www.keysight.com/find/supportrequest) if you 

encounter any other issue. 

 

Keysight N4917BACA Software Version 01.50.0003 

Release Date February 14, 2019 

Operating System Microsoft Windows 7 (64 bit)  

Microsoft Windows 8 (64 bit) 

Microsoft Windows 10 (64 bit) 

Memory 8 GB RAM [minimum] 

Display resolution WXGA+ (1440 x 900) [minimum] 

PC Interfaces USB 

LAN 

GPIB (optional) 

Instrument Firmware M8040A BERT - M8070A/B System Software. For 

the supported versions see the Software Pre-

requisites row. 

DCA-M/DCA-X - FlexDCA version A.06.01.68 or 

later 

8164B LMS - Ver.V5.25 or later 

BERT M8040A-BU2 mainframe with USB option 

M8070A-0TP/ONP/1TP/1NP System Software. For 

the complete list of licenses, see Chapter 2 of the 

User Guide. 

M8045A-G32/0G3/0G4/801 High Performance 

BERT module 

M8057A Remote head for M8045A pattern 

generator, 1 channel 

M8046A-A32/801 Analyzer module 

Signal Generator for Sinusoidal and Gaussian Noise 

Interference 

M8195A-002/16G Arbitrary Waveform Generator or 

M8196A-002 Arbitrary Waveform Generator or 

81150A-001 Pulse Function Arbitrary Noise 

Generator or 

http://www.keysight.com/find/supportrequest
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81160A-001 Pulse Function Arbitrary Generator 

N5171B-503 EXG X-series RF Analog Signal 

Generator  

Lightwave Measurement System 8164B LMS Mainframe 

Tunable lasers  

81602A-013 Tunable Laser 1250-1370 nm or 

81606A-113 Tunable Laser 1240-1380 nm or 

81608A-113 Tunable Laser 1240-1380 nm or 

81609A-113 Tunable Laser 1240-1380 nm 

 

Reference Transmitters 

81490A-E05 Reference Transmitter or  

81490A-E09 Reference Transmitter or 

81490A-E10 Reference Transmitter (multimode – 

for SR only) 

81491A-085 Reference Transmitter (multimode - 

for SR only) 

81491A-135 Reference Transmitter 

81492A-E01 Reference Transmitter (56GBaud) 

 

81000FI Optical Connector Interface 

81000NI Optical Connector Interface 

 

Optical attenuators:  

81576A Attenuator module (straight SMF) or 

81577A Attenuator module (angled SMF) or 

N7761A external Attenuator (1 ch straight SMF) or 

N7762A external Attenuator (2 ch straight SMF) or 

N7764A external Attenuator (4 ch straight SMF) 

N7751A external Attenuator (1 ch with 2 optical 

power meter channels, SMF) 

N7752A external Attenuator (2 ch with 2 optical 

power meter channels, SMF) 

N7766A Optical Attenuator for Multimode Fiber 

(2ch) 

N7768A Optical Attenuator for Multimode Fiber 

(4ch) 

DCA-X Oscilloscope 86100D-ETR/PTB/200/201/300/401 DCA-X 

mainframe 
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86105D-281/IRC Electrical/Optical SMF module or 

86115D-282 /IRC Dual Optical SMF module 

 

86107A-020 Precision Time Base (not required, if 

DCA-X has the option –PTB) 

86115D-282/IRC 

Because of their low noise and superior speed, it is 

recommended to use DCA-M series oscilloscopes 

instead of DCA-X series oscilloscopes. 

DCA-M Oscilloscope N1092A one optical channel or 

N1092B two optical channels or 

N1092C one optical, two electrical channels or 

N1092D four optical channels or 

N1092E two optical, two electrical channels 

options LOJ/PLK/IRC/200/201/300/401/500 

Clock Recovery N1077A-232/SMS/JSA Optical/Electrical Clock 

Recovery 

Software Pre-requisites Keysight IO Library rev. 18.1 or above 

M8070B system software for M8000 series ver. 

6.0.100.2 or later and 

M8070ADVB Advanced Measurement Package for 

M8000 series ver. 1.0.59.0 

OR 

M8070A system software for M8000 series ver. 

5.1.50.2 

N1010A FlexDCA Remote Access System 

A.06.01.68 or later 

Application Requirements Keysight M8070A/B System Software. For the 

required licenses, see User Guide. 

Keysight M8045A with options G32 or G64; 0G3 or 

UG3; 0G4 or UG4; 801 

Keysight M8046A with options A32 or A64; 801 

Keysight N4917BACA 100G Optical Receiver Test 

Application. For the required licenses, see User 

Guide. 

File Name SetupM80RxIEEE100G01500003.exe 

License: Please see the product data sheet on keysight.com 
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Enhancements 

- Support for automated optical stressed receiver sensitivity test for optical transceivers in a 

CPRI (Option 10) Fronthaul environment in compliance with the following standards: 

o 100GBASE-LR4 (IEEE 802.3 2015 Clause 88) 

o 100GBASE-ER4 (IEEE 802.3 2015 Clause 88) 

o CPRI Specification V7.0 

The CPRI-Option 10 standard has currently been implemented as an experimental feature only. 

For more details, get in contact with Keysight support.  

- New licensing model. For details, refer to Chapter 2 of the N4917BACA User Guide. 

- Support for new reference transmitters:  

o 81491A-085 and 81491A-135 

o 81492A-E01 

- Support for new M8070B System Software for M8000 Series of BER Test Solutions. This 

also requires M8070ADVB Advanced Measurement Package for M8000 Series of BERT 

Test Solutions. 

- Support of new firmware versions 

o M8070B - 6.0.100.2 

▪ M8070ADVB Advanced Measurement Package for M8000 Series - 1.0.59.0 

o M8070A - 5.1.50.2 

o FlexDCA - A.06.01.68  

- Full support for remote interface 

- Improved organization of configuration parameters in logical groups 

- Added several new configuration variables in “BERT Settings” to adjust ED and CDR 

settings for receiver testing. 

Note: The new config variable “Jitter Tolerance CDR LBW Auto” is not listed yet in the user 

guide and remote guide. Use this variable to enable or disable the automatic loop 

bandwidth adjustment in case a clock data recovery (CDR) is used during jitter tolerance 

testing. 

 

Fixed defects 

- The connection diagrams now show the correct orientation and connection setting for the 

directional coupler used to combine the data pattern and the sinusoidal interference 

signal. 

- Fixed a defect that caused BER results from the DUT control interface (DCI) to throw an 

error and abort the receiver test. 
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- Fixed the behavior of configuration variable “Stressed Eye Calibration Power Mode” setting 

“Max”. The attenuation should be set to 0dB now, in case the maximum output power does 

not exceed the specified abs. max. optical output power (which will limit the power in that 

case). 

- Fixed a defect that caused an error when loading or saving test limit template files. 

- Fixed a defect that caused empty entries for some configuration variables. 

- Fixed a defect that caused the calibration to abort in some cases when taking a DCA 

screenshot. 

- Fixed a defect that caused all tests to be available even in case of missing instrument 

connections after loading a saved project. 

Known Issues 

- Unexpected behavior might be observed when running the software and the software 

prerequisites on Windows 10 operating system. As a workaround, ensure that you install 

and run the N4917BACA application and the other software prerequisites as an 

administrator. 

In scenarios where the user does not have administrator rights, the suggested workaround 

is to install the software and prerequisites as an administrator and enable full control 

(read, write access) mandatorily to the following folders: 

o C:\Program Files\Keysight\M8070A\Apps\N4917BACA 

o C:\ProgramData\Keysight\M8070A\Apps\N4917BACA 

o C:\ProgramData\Microsoft\Windows\Start Menu\Programs\Keysight M8070A 

Applications 

o C:\Users\Public\Documents\Keysight\M8070A\Apps\N4917BACA 

 

and preferably to the following additional folders: 

o C:\Users\<user_name>\Documents\Keysight\M8070A\Apps\N4917BACA 

o C:\Users\<user_name>\Documents\Keysight\M8070A\Apps\N4917BACA 

- When an appended series of calibrations fail during the first trial, the results of successive 

trials will not be displayed in the Results tab even if these calibrations were successful. 

Restart the series in this case or use “Replace results” to overwrite the results of the 

previous runs. 

- Depending on the targeted standard and particular HW configuration, a 6dB or 10dB 

attenuator might be required in the sinusoidal interference signal path. Use this approach 

when the calibration fails, and an error related to clipping of AWG amplitude is reported 

(Error message: Set range clipped).  

- The TDEC verified by the software and the one displayed in eye-mode measurement of the 

FlexDCA software using default parameters are based on different OMA definitions, 

resulting in different TDEC values in presence of strong ISI. The value reported by the 

N4917BACA software is measured compliant to the method defined in the standards.   
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- In some of the scenarios that involve the use of an external CDR for transmission standards 

where its usage is optional, calibrations might lead to failing results. 

- Laser safety errors are sometimes returned when the reference transmitter is calibrated, 

and an external TLS source is used. As a workaround restart the test task or reduce the 

maximum output power of the tunable laser (“Maximum TLS output Power” parameter in 

the Configure tab). Alternatively, toggle the “Switch off PG during REFTX recal” parameter 

in the Configure tab. 

- When the Keysight N77xx Viewer software is connected via USB to a N77xx type 

attenuator which is also used by the N4917BACA application, time-out errors might occur. 

To prevent these errors during ORST testing, disconnect the N77xx Viewer software from 

the attenuator.  

- In some non-EN-US locales, commas might be the preferred decimal mark instead of the 

decimal point. Similarly, use of digit group separators might be preferred in some locales. 

This might lead to misinterpretation of locale-specific formats when working with numeric 

values.  While the N4917BACA application has some validation mechanisms to check for 

any confusion arising out of the non EN-US formats, it is best to avoid the use of locale-

specific formats. Thus, use "point" as the decimal mark and avoid use of digit group 

separators. 

 

Please contact Keysight Technical Support (www.keysight.com/find/supportrequest) if you 

encounter any other issue. 

Keysight N4917BACA Software Version 01.00.0005 

Release Date July 19, 2018 

Operating System Microsoft Windows 7 (64 bit)  

Microsoft Windows 8 (64 bit) 

Microsoft Windows 10 (64 bit) 

Memory 8 GB RAM [minimum] 

Display resolution WXGA+ (1440 x 900) [minimum] 

PC Interfaces USB 

LAN 

GPIB (optional) 

Instrument Firmware M8040A BERT - M8070A System Software 

86100D DCA-M/DCA-X - FlexDCA version A.05.71 

or later 

8164B LMS - Ver.V5.25 or later 

81490A Ref Tx - Ver.5.01 or later 

BERT M8040A-BU2 mainframe with USB option 

http://www.keysight.com/find/supportrequest
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M8070A-0TP/ONP/1TP/1NP System Software 

M8045A-G32/0G3/0G4/801 High Performance 

BERT module 

M8057A Remote head for M8045A pattern 

generator, 1 channel 

M8046A-A32/801 Analyzer module 

Signal Generator for Sinusoidal and Gaussian Noise 

Interference 

M8195A-002/16G Arbitrary Waveform Generator or 

M8196A-002 Arbitrary Waveform Generator or 

81150A-001 Pulse Function Arbitrary Noise 

Generator or 

81160A-001 Pulse Function Arbitrary Generator 

N5171B-503 EXG X-series RF Analog Signal 

Generator  

 

Lightwave Measurement System 8164B LMS Mainframe 

Tunable lasers  

81602A-013 Tunable Laser 1250-1370 nm or 

81606A-113 Tunable Laser 1240-1380 nm or 

81608A-113 Tunable Laser 1240-1380 nm or 

81609A-113 Tunable Laser 1240-1380 nm 

 

Reference Transmitters 

81490A-E05 Reference Transmitter or  

81490A-E09 Reference Transmitter or 

81490A-E10 Reference Transmitter (multimode – 

for SR only) 

 

81000FI Optical Connector Interface 

81000NI Optical Connector Interface 

 

Optical attenuators:  

81576A Attenuator module (straight SMF) or 

81577A Attenuator module (angled SMF) or 

N7761A external Attenuator (1 ch straight SMF) or 

N7762A external Attenuator (2 ch straight SMF) or 

N7764A external Attenuator (4 ch straight SMF) 

N7751A external Attenuator (1 ch with 2 optical 

power meter channels, SMF) 
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N7752A external Attenuator (2 ch with 2 optical 

power meter channels, SMF) 

N7766A Optical Attenuator for Multimode Fiber 

(2ch) 

N7768A Optical Attenuator for Multimode Fiber 

(4ch) 

 

DCA-X Oscilloscope 86100D-ETR/PTB/200/201/300/401 DCA-X 

mainframe 

86105D-281/IRC Electrical/Optical SMF module or 

86115D-282 /IRC Dual Optical SMF module 

 

86107A-020 Precision Time Base (not required, if 

DCA-X has the option –PTB) 

86115D-282/IRC 

DCA-M Oscilloscope N1092A one optical channel or 

N1092B two optical channels or 

N1092C one optical, two electrical channels or 

N1092D four optical channels or 

N1092E two optical, two electrical channels 

options LOJ/PLK/IRC/200/201/300/401/500 

Clock Recovery N1077A-232/SMS/JSA Optical/Electrical Clock 

Recovery 

Software Pre-requisites Keysight IO Library rev. 18.1 or above 

M8070A system software for M8000 series Ver. 

4.0.100.2 or later 

N1010A FlexDCA Remote Access System A.05.71 

or later 

Application Requirements Keysight M8070A System Software Version: 

4.0.100.2 and above with options 0TP 

Keysight M8045A with options G32 or G64; 0G3 or 

UG3; 0G4 or UG4; 801 

Keysight M8046A with options A32 or A64; 801 

Keysight N4917BACA 100G Optical Receiver Test 

Application  

N4917BACA-1TP or N4917BACA-1NP 

File Name SetupM80RxIEEE100G01000005.exe 

License: Please see the product data sheet on keysight.com 
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Features 

First release of Keysight N4917BACA 100G Optical Receiver Test Application. The application 

provides a platform for automated stressed receiver sensitivity test, which is compliant with the 

following IEEE standards and related Multi Source Agreements (MSA): 

- 25GBASE-ER/-LR/-SR 

- 100GBASE-LR4/-ER4/-SR4 

- CLR4, CWDM4, 4WDM 

The solution consists of several test instruments such as a Bit Error Rate Tester (BERT), an 

arbitrary waveform generator (AWG), Digital Sampling Scope (DCA), Optical Reference 

Transmitter, Tunable Laser, and Optical Attenuator operating together with the N4917BACA 

software package. 

 

Some salient features of the N4917BACA 100G Optical Receiver Test Application include: 

- Remote control of all the test instrumentation 

- Automated calibration of the optical stressed eye parameters (ER, VECP/SEC, OMA, J2, 

J4, and J9) following the procedure recommended by IEEE 

- Adjustable target values for the above-mentioned metrics 

- Automated Stress Receiver Sensitivity, jitter tolerance, and eye mask tests 

Known Issues 

- Remote Interface feature (View > Preference > Remote) is not officially supported.  For 

instance, “Remote Interface Hint” (right click on “Tests” or “Utility Functions” in 

Select Tests” Tab) or the reference manual (Help > Automation > Remote Interface) are 

not final. 

- When an appended series of calibrations fail during the first trial, the results of successive 

trials will not be displayed in the Results tab even if these calibrations were successful. 

Restart the series in this case or use “Replace results” to overwrite the results of the 

previous runs. 

- Depending on the targeted standard and particular HW configuration, a 6dB or 10dB 

attenuator might be required in the sinusoidal interference signal path. Use this approach 

when the calibration fails, and an error related to clipping of AWG amplitude is reported 

(Error message: Set range clipped).  

- The TDEC verified by the software and the one displayed in eye-mode measurement of the 

FlexDCA software using default parameters are based on different OMA definitions, 

resulting in different TDEC values in presence of strong ISI. The value reported by the 

N4917BACA software is measured compliant to the method defined in the standards.   

- The external CDR is not supported for flavors where its usage is optional. Use a clean clock 

instead (e.g., from pattern generator). 
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- Laser safety errors are sometimes returned when the reference transmitter is calibrated, 

and an external TLS source is used. As a workaround restart the test task or reduce the 

maximum output power of the tunable laser (“Maximum TLS output Power” parameter in 

the configure tab). 

 

Please contact Keysight Technical Support (www.keysight.com/find/supportrequest) if you 

encounter any other issue. 

http://www.keysight.com/find/supportrequest

